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 RSServer Basics 

 

  RunScore is a complex and powerful race scoring program that can make your like easier and your scoring fast 

and efficient.  It is not the easiest program to use, but it is the most powerful.  With a little effort and a little 

learning on your part, you can use RunScore to do any race that you want and provide any type results.  This 

document is a “Living Document” and will continually be updated with inputs from all the other RunScore 

users out there.  This is a tool to help all the RunScore users. 

 

Install RSServer 

 

  The first thing that you need to do, is to download and install the program.  You will need to go to the 

RunScore Home Page, “http://www.RunScore.com/”, and click on the “Order/Download” tab.  You will then 

have a choice of “RunScoreSetup.exe”, “RSClientSetup.exe”, or “RSWsetup.exe” for the installation files.  

You need to save “RunScoreSetup.exe” to your Desktop and use it to install RunScore Server and all needed 

program files for Server or Client operations.  The file “RSClientSetup.exe” will only install the Client files on 

machines that you only want to use as RSClient machines.  “RSWsetup.exe” is the installation file for the older 

RunScore for Windows. 

 

  After you have saved “RunScoreSetup.exe” to your Desktop, Double-click on the program to start the 

installation process.  NOTE:  If you are using Windows Vista or Windows 7, you may need to “Run as 

Administrator” to install.  Right-click “RunScoreSetup.exe” and select the item “Run as Administrator” from 

the popup menu, to install. 

 

  It is recommended that you install in the default folder of “c:\RunScore”.  The first time you install on a 

machine you will want to do the “Typical” to install all files.  If you later want to install a newer version, you 

would then select the “Custom” to install just the newer files.  With the “Custom” choice, you can choose the 

files that you want to install. This way you can install just some of the files included in the full install. 

 

  After you install RunScore, you can open the program the first time, by double-clicking the RSServer Icon that 

the installation created on your desktop.  Ignore the RSClient Icon for now.   

 

  If you are evaluating the software, you will get a registration reminder for the first 31 days every time you run 

the software, but will have a fully functional installation.  At the end of the 31 day evaluation period, certain 

functions of the program will be disabled and you can only use the program for data entry. 

 

  If you purchased the software, you will want to register the software with the UserID and Key that you received 

when purchasing the software.  Select “Tools>Register” and input the License Name and License Key from your 

purchase.  Make sure you input them exactly as they are in your registration email.  This will make your copy of 

RunScore fully functional for the rest of the time you own or use this version of RunScore. 
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   Also, take time to move the installation file from your desktop to a safe and secure location to save the 

installation for the Version that you purchased, in case you have to install it again or want to install the program 

on another machine.    

 

 You have one year to download and install any and all updates or changes to RunScore.  The latest official 

stable release of RunScore is found in the “RunScoreSetup.exe”.   This Stable Version will be updated at 

normal intervals after fixes and new functions have been checked out and are found stable enough to be 

included in the stable version. 
 

  These fixes and new functions for RunScore are found in the “RunScore Updates” section of the web site.  

You can try out these new functions to use at your own risk for the first year.  If you install any Updates after the 

one year anniversary of your purchase, you will need to pay an Update fee to keep your program fully 

functional. 

 

  Just save the “RSServerUpdate.exe” and the “RSClientUpdate.exe” files to your computer.  When you run 

these update programs, when the Unzip window opens, select “Unzip” to replace the files in your 

“c:\RunScore” and “c:\RunScore\client” folders.  When the files have been unzipped successfully, click on 

“OK”, then close the Self-Extractor window.  If you are happy with your purchased Version of RunScore, you 

need never do anything else and can continue to use the software forever. 
 

Getting Started 

 
  Double-click the RSServer Icon created on your desktop, to open RSServer.  You should see the following 

screen: 

  Notice the top border has the Icon and “RunScore”; this is where the info will fill in when you open a Race 

Folder.  The menu line has “File”, “Tools”, Windows”, and “Help”, with an Icon line below with most of them 

“Grayed Out” until you open a race.  The third line is the set of Master menu buttons that allow you to access 

the “Enter/Edit Names”, “Browse”, “Results”, “Listing”, “Init.”, “Misc.” Screens and to select “Quit”. 
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 Notice that without a race folder open, these buttons are “Grayed Out” also.  Above the Logo, is the white 

window with your Registration info, the Version and Level info for the copy of RunScore you are using and 

clickable links to “support@RunScore.com”, “www.RunScore.com”, and a direct link to “Updates”.   On the 

bottom border at the far right is the Status of the “NumLock” and “CapsLock” keys on your keyboard. 

 

  One of the most powerful tools in RunScore is the “Help”.  Most people never look at it.  Take time to open 

“Help” from the Menu Item or the Icon.  Look at the “Content” tab and read the “Introduction” and “Getting 

Started” sections.  Later, when you come up with a question, use the “Search” tab to find info on what you don’t 

understand.  Say you have questions on “Select Timing”, then open “Help”, Search on “Select Timing” and you 

will see a set of Topics matching your search.  If you double-click on “Select Timing”, you will open the Help 

section on “Select Timing”.  If that does not answer your question, you can look at some of the other topics.  If 

that fails, you can then contact “support@RunScore.com” to ask your question from Tech Support.  If you have 

a question on how to better use RSServer, or on how other people use, you can go to the Yahoo RunScore group 

“http://tech.groups.yahoo.com/group/RunScore/” and join the group to get on the Mailing List or even to see all 

past information. 

 

  Click on “Tools>Preferences” to enter the Preferences window. 
 

 
 

Next, click on Help to review all the preferences that are available for use in RunScore.  Select the items that 

you want to use whenever RunScore starts.  It is important to set an Alternate folder for both race results and the 

entries.  Also, you need to check the boxes for the functions that make that work.  
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 RunScore Basics 

 

  RunScore’s program files are found in the RunScore directory “c:\RunScore” and the race files should be in 

folders under “c:\RunScore”.  The main program files for RunScore are “RSServer.exe” (RunScore program 

executable) and “RSServer.chm” (compiled RunScore Help file).  Other provided files are installed in a 

“Common” folder under the RunScore folder and include all the “TAC” and “Age Graded” files that RunScore 

uses for a couple of special features.  It also includes a sample Zip code database to be used for automatically 

filling in the Town and State for known Zip codes. 

 

  The basic install of RunScore, also copies a “SampleRaces” folder that provides races with a starting point for 

you to use in RSServer.    There also is a set of “Advanced Sample Races” installed under the “c:\RunScore” 

folder that provide you with a more robust set of listing files and reports that mimic all the other Race Scoring 

programs out there. 

 

  To get started, you want to “Open” a race.  Select “File>Open Race” or the first Icon (Yellow folder with a 

green arrow out of it).  When the “Open Race” window opens, look in the right window and you should see a 

folder named “SampleRaces”.  Double-click on that folder, then double-click on the “Sample” folder when it 

comes up, you will now see two “.frm” files.  Select “Entries.frm” and click on “Open”. 

 

 You will now see the info on the top border:  “C:\RunScore\SampleRaces\Sample\Entries---06/19/2010 -  

Vernon XX” and the Master Menu buttons are no longer “Grayed Out”. 

 

  Now click the “Enter” Master Menu button or select “Database>Enter/Edit Names”.  You will now see the 

“Enter/Edit Names” screen.  This is the basic structure of the Database file for your race. 
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Race Folder Basics 

 

  Each race folder will contain the basic files needed to work your race.  The first file of importance is 

“Entries.frm”, the database format file for RunScore’s database file, “Entries.dta”.  When you opened the 

“Sample” race, you opened this file.  The database format is adjusted or created using the RunScore tool 

“Design Screen”. This screen allows you to create or edit “Fields” and “Labels” to be used under RunScore as a 

Database Entry Form that you see in the “Enter/Edit Names” screen we just opened.  Now enter the “Design 

Screen” mode by selecting the “Tools>Enter/Edit Names>Design Screen”, clicking on “OK to close this race”. 

 

You will see the “Label” “No.” and 

the white “Field” on the first line.   

 

Double-click on the white window 

to the right of “No.” to bring up the 

“Properties”. 

 

 Each of these “Properties” 

windows allows you to set “Field 

Name”, “Field Length”, and 

“Search Length”.  You can then set 

options for “Search Field” through 

“Date Field” and set a “Minimum 

Value” through “Allowed values” to 

set up how your race database 

works.  Take some time to review 

these options in the RunScore Help 

for “Design Screen”.  This will help 

you understand how to set up your 

database to make things work easier 

and better in RunScore.  Now, 

“Cancel” the “Properties” screen 

and click “Esc:Done”. 

 

  Now select “File” and look at the “Recently opened 

races” near the bottom of the screen and select the line 

“C:\RunScore\SampleRaces\Sample\Entries.frm” to 

reopen the “Sample” race. 

 

   You can always go back in to the Design screen and add 

or edit Fields in your DTA and RunScore will rebuild to 

make things work.  Also, you can “Right-Click” the field 

in the “Enter/Edit Names” screen, select “Properties” from 

the pop up menu and edit most of the properties for that 

field on the fly.  You cannot change the database 

structure/size or the “Template” value, but all others are 

available here. 
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RunScore Database Operations 

 

  You can view the Database by using the “Enter/Edit Name” screen or the “Browse” screen.  Click on the 

“Enter” Master Menu button to open the “Enter/Edit Name” screen and click on the “PageDown” key to display 

record 1. 

  Notice that the sample data from RunScore for this race has bib number “1” and the info for this person 

entered into the database.  You can use “PageUp” and “PageDown” to cycle through the records.  Also “Ctrl-

Home” and “Ctrl-End” will move you directly to the first and last records.  These functions can also be 

accomplished with the “Black Arrows” on the Icon bar, with “|<-” sending you to the first record, “<-” previous 

record, “->” next record, and finally “->|” to send you to the last record. 

 

  Take time to review help for this screen, by hitting the “F1” key while in this screen.  RunScore Help will open 

with the info on how to use this screen and edit and work with data in the database record that you have open in 

this “Enter/Edit Names” screen. 

 

  You can also use the “Browse” screen to see multiple records in a “Spread Sheet” type format to view more 

than one record at a time.   
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  Again, take time to review the Help on the “Browse” screen by hitting the “F1” key to open help on “Browse 

Database”.  This also gives you some info on special functions for the “Browse Screen”. 
 

RunScore Listing File Screen 

 

 

  Next, open the “Listing” screen, by clicking the “Listing” Master Menu button.  This will open a screen with 

all the listing files in your race folder that have an “.lst” extension. 

 

 
 

  Notice that while this screen is open, more of the Icons are no longer “Grayed Out” and can be used.  We will 

cover these later. 
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RunScore Important Files 

 

 

  To start working with RunScore, we will first “Clone” this “Sample” race and call it “Training”.  Select 

“File>Save Race as” and type the new name for your race folder as “Training”.  Notice the location of the new 

folder to make sure that it is under the “c:\RunScore” folder or any sub-folder you might use to group your races 

like “c:\RunScore\races”.   Click on “OK to close race”, RunScore will close the sample race and create your 

new race folder, notice that the top border will now show:  “c:\RunScore\training\Entries---06+/19/2010 - 

Vernon XX”.  You have now cloned the Sample race to a new folder that you can play with. 

 

  The first step in setting up your race is to adjust your format and settings for the specific Race Folder you are 

going to use.  One of the most powerful tools in RunScore is the “Entries.ini” file.  This file can help you 

update your Entries, System Variables, and Custom Variables.  With these functions, you can make your life a 

lot easier.  Click on the “Misc.” Master Menu button and select “Edit Entries.ini update file” to open the INI.. 
 

race name           Vernon XX 

date format      MM/DD/YY 

race date           06/19/2010 

date of birth field birthdate 

age field           AGE 

%race location%     Vernon, NY 

%race distance%     20 km 

%long race name%    FORTIETH ANNUAL VERNON XX 

%sub name%          TWENTY KILOMETER ROAD RACE 

%reg number%        NY05034AM   

%weather%           Cool, rainy, 58 deg 

%male record%       1:03:17 by Tom Carmon in 1981" 

%female record%     1:16:03 by Suzanne Gary in 1980 

Look up             \RunScore\common\zip 

  

   You can see that the INI file contains some System Variables like “Race Name” and “Race Date” that are 

defined here and others like “Date” and “Time” that can be used later to report the current date or time.  

“Custom Variables” can be defined like those above and used later in things like “Racename”, so that they only 

need to be identified once in the INI file.   

 

  The INI file is used to update records in the database in several ways.  One of the most useful tools, is the 

procedure to fill the DIV field with information to show the runner’s place in his or her Age Group.  This is 

done with a Macro in the INI.  The steps in the Macro are contained in the [Control] section that calls values 

from the [Data] section.  The [Control] section looks like: 

 
[control] 

select              sex 

EQ                  %1 

and 

select              age 

GE                  %2 

and 

select              age 

LE                  %3 

selected            DIV 

selected message    %4 
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Next, the [Data] section looks like: 

 
[data] 

M  1 19 M0119 

F  1 19 F0119 

M 20 29 M2029 

F 20 29 F2029 

M 30 39 M3039 

F 30 39 F3039 

M 40 49 M4049 

F 40 49 F4049 

M 50 99 M5099 

F 50 99 F5099 

 

  Now, when a record is saved by “F4” (update), “F10” or “F12” (save), or any other method that automatically 

saves the record, the INI computes the DIV field, by looking at “%1” for “M” or “F” for sex, then the age 

between “%2” and “%3”, to fill DIV with the “%4” value.  Thus a 32 year old female would get a DIV value of 

“F3039”.  RunScore then takes this value and compares this person against all other people with a DIV value of 

“F3039” to show the finish position in that age group. 

 

  If you race has different age groups, you just need to change the [Data] section.  If your Race Director wants to 

use 5 year age groups, you would just adjust the section like this: 

 

 
[data] 

M  1 09 M0109 

F  1 09 F0109 

M 10 14 M1014 

F 10 14 F1014 

M 15 19 M1529 

F 15 19 F1529 

M 20 24 M2024 

F 20 24 F2024 

M 25 29 M2529 

F 25 29 F2529 

M 30 34 M3034 

F 30 34 F3034 

M 35 39 M3529 

F 35 39 F3529 

M 40 44 M4044 

F 40 44 F4044 

M 45 49 M4529 

F 45 49 F4529 

M 50 99 M5099 

F 50 99 F5099 

 

  Review the help section on “Updating Entries, System Variables, and Custom Variables” to learn more about 

the power of the INI file and how you can use it to make your life easier and your scoring simpler.   
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  The next set of important files that you work with in a race, are your “.xml” files. These “.xml” files cannot 

normally be edited directly from an editor in RunScore, but are edited directly by RunScore.  These are used by 

RunScore to control certain values for your database and reside in “Entries.val.xml” and “Entries.def.xml”.  

These values are controlled by the “Properties” screens for each field in your database as you set them with the 

“Design Screen” or by right-clicking the field in the “Enter/Edit Names” screen and selecting “Properties”.   

 

   

Next is the list of “Events” that you use to score the race, these reside 

in the “Events.xml” file and can be accessed from the “Results” Master 

Menu button.  This will show a drop-down list of the “Events” in the 

“Events.xml” file.    When you select one of these “Events”, “Time”, it 

will open a “Results Screen. 

 

  

  

To edit/modify these events, you click “Misc.” on the Master Menu 

button and select “Edit list of events” item.   RunScore uses these 

events to contain your Times and Bib numbers in a “Results” screen 

that is used for results and awards later.  Normally you will have a 

finish event called “Time”, followed by a “Select” event for “Select 

Times from an “External Timer” to compare you finish times and 

finish order during Race Reduction. 

 

  From this screen, you can edit, add, move, delete, cut or paste an 

Event. 

 

 

 

 

 

 

 

 

 

 

 

  When you select and Edit “Time”, you will see the options 

for the event.  This includes the “Name of event”, toggles to 

mark this as a “Select Event” or “Lap Event”, field to set the 

“Max number of finishers”, and a toggle for setting “Not 

found bibs added to DB” as the default for this event.  On the 

right side, are the toggles to set the “Type of Event”.  

Normally you leave this set as “Default” unless you are 

doing a Tag/Chip race and want to use the special functions 

that work with those systems. 

 

 

 
 

 

 
 



   

11 

 

RunScore Data Entry from entry forms  
 

 

Now you can set up to enter the data from the entry forms and have the data in the DTA file ready to score the 

race or print reports from.  After opening the race, then you want to select “File>Enter/Edit Names” or click the 

“Enter” on the Master buttons. 

 

  When you first open an Enter/Edit names screen, you open in a new record, notice how it is blank and at the 

bottom of the screen, shows the number of Entries and Records, but does not show a Record number.  Just start 

typing in the data that you want from the entry forms.  If you type over the info already in a record, when you 

save that record, the old data will be lost.  If there is data on the screen, hit “F9” to get a “New Record”. 

 

  Notice the commands are listed on the bottom border of the “Enter/Edit Names” window.   After you have 

entered the data, you will want to save or update the record.  You do that by “F4” update and stay in the record 

or “F10” or ”F12” that save and step to a new record, and add next bib number to continue adding data quickly.  

Take time to review the commands by hitting “F1” to see what can be used to shortcut or help your data entry.  

You can get rid of a new record at any time by hitting “esc” or just exiting the screen.  Review the commands to 

see how “F3” Search and “F7” Ditto works.  These are very helpful commands. 
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Entering Results Data 

 

  Now we are ready to add the results data that allows us to score the race.  The first step in this is to enter one of 

the events you set up for the race.  Click on “Results” on the Master Menu buttons and select “Time”. 

 

  Notice in the Results Screen, you have a column for 

Bib Numbers, Times, Select Times, and can display the 

first several Searchable fields in the data base.  When 

you first enter your race to use these events, you will 

want to use the “Init” button to select “Intialize Results” 

to clear the results screen of old or testing data.  You 

can select “Clear All” to get rid of all times, or just 

select the event and hit “OK” to clear one event. 

 

  When you first bring in times for your finishers, only 

the Time column will fill.  This gives you the finish 

times of all finishers.  Next, you scan or type in the bib 

numbers from your stringers to show the finish order of 

to match those times.  It is also important to have 

“Select Times” if you can, where you actually record the 

bib number and finish time of a select number of 

finishers to ensure that your two columns match up. 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Again, spend 

some time in the Help area for this screen by hitting “F1”.  Review the commands and capabilities.  You can 

manually enter or download times and information from an External Timer, like a Time Machine or a Summit 

Timer.  You need to connect the timer to your computer and then “Initialize External Timers” to let RunScore 

communicate with the timer. 
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  Open the “Initialize External Timers” screen and set up the timers to prepare for download of times at the end 

of a race, or let that data come in live during the race. 

 

 

 

Again, spend some time and explore the 

“Help” section by clicking the “Help” 

button.   

 

 

  

 

 

 

 

 Now you can scan in the Bibs or enter 

them by hand.  When you start typing in the bibs, if you have select times, they will show if you have selected 

“F6” and the Field data from the Database will show if you have selected “F7”. 

 

   

Review the section of help on “Enter/Edit Results” to understand how to use Results to score your race.  A lot of 

experienced timers NEVER delete a time or bib number, they add times, edit bib numbers, and add bandits to 

make their scoring match.  Also, remember to periodically save your results.  We also recommend that you set 

up Preferences to “Auto Save Results” and “Save all Results”.  You can set the time for Auto Saves, but it 

won’t affect your performance, so we recommend that you use 1 minute. 

 
 

Listings, Results, and Awards 

 

  To program and use RunScore to its fullest, you need to have an understanding of the way RunScore uses 

Listing and Macro files to give you the results or reports you use to score a race.  You will be using these files 

for all products that are needed for your race. 

 

  The primary file that you use is a RunScore Listing file (LST) that is a simple script to use modules and 

commands from the RunScore program to provide results and reports.  To do more complex actions, we use 

RunScore Macro files (RSM) that are controlled by Parameter Passing listing files (@) that call the RSM files 

and supply the variables to the RSM file to drive the Macro operations.  We can also Chain several Macros 

together to use the same Parameters across two sets of RSM files. 

 
 

 



   

14 

 

  These listing files will be displayed in the “Listing” screen, take time to click on “Listing” on the Master Menu 

Buttons.  You will see the “.LST” files that come with the “Sample” race: 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 First, the RunScore scripts usually start with a Comment line.  This line is designated by the "Comment" 

command and the text that starts in column 21 or beyond is ignored by the listing file and just used for 

information.  You can also use an "*" or a blank space in column 1 to denote that all following text is just a 

comment and should not be acted upon.  Here are the examples of comments:  

 
Comment             This is a results printout. 

* Overall results report 

  This will list the overall results for all participants. 

  

  The use of an "*" or a blank space in column 1 can also be used to “Comment Out” or disregard a normal 

command line.  Then later, this "*" or a blank space in column 1 can be removed to let the command run again. 

 

  The next thing you may have to do is to use printer commands to make your results look the way you want to 

look like.  Here are the commands in the “Results.lst” file: 

 
font name           arial 

*Font Size           30 

Lines/inch          5 
 

  The set of commands control thee Page format section and is used to set up the page for the reports.  Here is an 

example of my page format section from the “Results.lst” file: 
 

From Page Number    1 

To Page Number      100 

form feed at end 

no page numbers 

 

  Now comes the Headers and Footers.  The header information is placed between the following commands: 
 

Header 

.include            RACENAME 

.End of Header 
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  Text can be put between these lines or files can be called with the ".include" command will be included in the 

header to appear at the top of each page.  This is good for placing your titles and the “racename” file at the top 

of the report.  The ".CE" command is used to center text when placed in a header or header file.  Select 

“File>Open File” or click on the “File Open” icon and find the file “racename”.  You will see: 
 

.ce %long race name% 

.ce %sub name% 

.ce USATF Certified.  Registration No. %reg number% 

.ce %race location%    %race date%  Weather: %weather% 

 
 

  The values defined in the “Entries.ini” file will now be placed in the  “Racename” file to look like: 
 

                         FORTIETH ANNUAL VERNON XX 

                        TWENTY KILOMETER ROAD RACE 

               USATF Certified.  Registration No. NY05034AM 

          Vernon, NY    06/19/2010  Weather: Cool, rainy, 58 deg 

 
 

    The Footer command is the same as the Header command, but the text is placed at the bottom of the page.   

With the new Variable capability, it  is easy to add a Date and Time stamp on reports, by adding the following 

Footer: 
 

Footer 

     %Time% %Date% 

.end of footer 

 

  Now we come to the meat of scripting or programming under RunScore.  This starts with selecting the fields 

that you wish to have in your report.  This is done with simple Field commands and the Field Name at column 

21.  You now list all of the fields that you want to show in your product.  The "Fieldlst" file looks like: 
 

Field               FIRST NAME 

Field Header        NAME 

Field Length        7 

Squeeze 

Field               LAST NAME 

Field Header 

Field Length        11 

 

  This file would be used by the ".include" command and is the same as calling for a custom Header for complex 

races like triathlons that to include special titles for the race results columns.  Here is a simple calling of fields 

from the “Results.lst” file: 
 

.include            fieldlst 

Field               AGE 

Field               SEX 

Field               CITY 

Field Length        15 

Field               STATE 

Field               CLUB  
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 This will print out the Name, sex, age, city and state for each individual in the database for this report.  Just 

combining the things we have brought up in these last few paragraphs, you have a nice listing of the entrants.  

The actual “Entries.lst” file might looks like: 

 
comment             Entry list 

no total 

orientation         landscape 

line length         70 

 

Header 

.ce ******************** ENTRY LIST ********************* 

.include            racename 

.end of header 

From Page Number    1 

To Page Number      1000 

Select              NO. 

>                   0 

Sort                NO. 

Field               NO. 

.include            FIELDLST 

Field               AGE 

Field               SEX 

Field               CITY 

Field               STATE 

Field               CLUB 

Date  

 

  You will notice in the above listing file that was named "Entries.lst", that all the entrants would be listed in a 

nice little report.  You notice that we are using the "Select" command to limit what is shown in this report, to 

only records with Bib Numbers not the Bandit value, with Bib Number Zero.  The report is also sorted by the 

bib number.  You could also sort by last name to do it in Alphabetical order. 

 

  The next thing you do is tell the listing file what kind of results you want to show for scoring files.  RunScore 

will give you finish order and times if you just add the "Event" command.  If you remember when we looked at 

the Events in the “Misc.>Edit list of events”, we saw the first and major event was “Time”.   

 

To use the “Time” event in a listing file to show all the finishers in the Event “Time”, all we have to do is add 

the line: 

 
Event               time 

 

 

 

 

 

 

 

 

  Now, all finishers with times would be listed in finish order and have their place and times listed.  The 

“Results.lst” report itself will look something like this: 
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                         FORTIETH ANNUAL VERNON XX 

                        TWENTY KILOMETER ROAD RACE 

               USATF Certified.  Registration No. NY05034AM 

          Vernon, NY    06/19/2010  Weather: Cool, rainy, 58 deg 

  

Place Name                Age S City            St Club       Time    Pace   

===== =================== === = =============== == ========== ======= =====  

    1 Ken Swift            53 M Swift Town      KY Swift RR   1:03:44  5:08  

    2 Dave Derry              M Thompsonville   RI            1:04:40  5:13  

    3 Steve Demo           54 M Mount Morrow    NY            1:07:28  5:26  

    4 Tom Jester           57 M Vernon          NY Vernon RC  1:08:13  5:30  

    5 Andrew Olson         40 M Westtown        NY Nite Serv  1:08:21  5:30  

 

  You can also limit the results, with the "Select" command to look for all males, by adding the lines: 

 
SELECT              SEX 

EQ                  M 

 

  The results would then only show the Male Finishers, and with a simple change in the Header, you would 

identify this new listing as the "Male Overall Run Results".  You could also use an age range to produce masters 

results, the command lines would look like: 

 
SELECT              AGE 

GE                  40 

 

  You can add the "Pace" command at the end of the listing with the distance in the 21st column to have 

RunScore compute and list the Pace for each finisher: 

 
Event               time 

Pace                5K 

 

  You can do complex limiting of results by using the "And" or the "Or" command.  If you wanted to print out 

all the male master finishers, you would use the following commands: 

 
SELECT              Sex 

EQ                  M 

and 

SELECT              Age 

GE                  40 

Event               time 

Pace                5K 

 

  When using the "And" command, both conditions must be met for results.  The "Or" command requires either 

condition to be met.  Thus you could look for Race equal to "R" or "C" to find all finishers except the walkers.   

 

<  or LT          "Less than" 

<= or LE         "Less than or equal to" 

= or EQ           "Equal to" 

>=  or GE         "Greater than or equal to" 

> or GT          "Greater than" 

<> or NE          "Not Equal to" 

  SW  “Starts With” 
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  You can also use operators as you see above, like "=", ">", ">=", or others to limit to specific groups.  You 

must be careful when you mix the "And" or "Or" operators in RunScore.  You should always group your “Or” 

operators before you “And” operators in a listing. 

 
SELECT              Race 

EQ                  R 

or 

SELECT              Race 

EQ                  C 

And 

Select              Sex 

EQ                  M 

 

 You can also use negative operators to accomplish the same thing: 

 
SELECT              Race 

NE                  W 

And 

Select              Sex 

EQ                  M 

 

  Both of these would select all the people with a race of "R", or "C" and sex of male, if the race values were 

“C”, “R”, and “W”. 

 

  Next we need to talk about the “Eventlst” file.  This is used to define which Events you are using and any 

modifiers to those events.   Here is the “Eventlst” file from the “Sample” race 

 
* Following line for single-chute 

Event               TIME 

 

  In the above, we only use one finish event called “Time” and it can be called for results listings using the 

“.include” command. 

 

  If you have delayed starts for walkers or other groups that need to have an adjustment made to produce the 

correct time for them as they finish the race.  This is done by adjusting the times for people who take off after 

the main start and added for people who take off before the main start.   

 

  Thus, wheelchairs might take off two minutes before the main runners and walkers take off 2 minutes after the 

main start.  You do this by having a specific “Eventlst” for each group.  Thus, you could have an “Eventlst.wlk” 

and “Eventlst.chr” to adjust those times.  For “Eventlst.wlk”, it would look like: 

 
* Following line for single-chute late start 

Event               TIME 

Minus               2:00 

 

.  For “Eventlst.chr”, it would look like: 

 
* Following line for single-chute late start 

Event               TIME 

Plus                2:00 
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  This is all good for when you just use elapsed times from the time of the start for the race.  Thus, you start your 

“External Timers” and “Stopwatches” at the sound of the gun for the start and you have “Gun Times” for every 

participant.  You will then use the same “Plus” or “Minus” command to adjust for early or late starts for your 

Wheelchairs, Walkers, or any special group with a separate starting time.  This is how timers had done timing 

for years. 

 

  Now, with the advent of “Transponder” timing, timers have started to use the Time of Day (TOD) to record 

official times for people at the starts, splits, and finish of a race.  These times are reported to RunScore as the 

finish TOD (07:47:08.58) and need to be converted to the elapsed time by subtracting the Gun Time in TOD 

(07:30:02.23), to arrive at the elapsed time of 17:06.35 for awards and results. 

 

  These corrections are handled just like elapsed times, but are only done with the “Minus” command, since we 

are adjusting for separate “Gun Times”.  This looks almost like above, but instead of the minute correction, you 

use the “Gun Time”: 

 
* Following line for single-chute Gun start 

Event               TIME 

Minus               07:30:02.23 

 

  This can also be done simply with a Custom Variable in the INI called %gun%.  You now set the “Gun Time” 

from the official start in my INI and you can use it in any listing file by calling: 

 
* Following line for single-chute Gun start 

Event               TIME 

Minus               %gun% 

 

  You can also use separate “Gun Times” for the Wheelchairs, Walkers, or any special group with a separate 

starting time, by just assigning a variable like:  %gun chair%, %gun walk%, or %gun special%.  This way, after 

the start, you only have to change the Gun Times in one place.   

 

  The other strengths of using TOD, is that you can SYNC all my timers first thing in the morning and not have 

to worry about matching them after the starting gun.  The only one that you have to do by elapsed, is the  

race clock. 
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Awards 
 

  OK, now you need to use all that we talked about before to produce the Awards for the race.  All you have to 

do is use all the programming capabilities in RunScore to produce your printouts.  You don't need to create a 

different listing file for each award that the Race Director wants to give out.  You can use the RunScore macro 

function to group all these results into one report or awards package. 

 

  You start this by creating the Parameter Passing listing files (@) that calls the RSM files to create the results 

you need.  These files are designated by the first character of the name being a "@" to designate that the 

commands inside include calls to RunScore Macro files (RSM) to produce the product. 

  This would start with comments about the listing file that would also be shown when the file name was 

highlighted with the mouse at the bottom of the Listings Window to help you understand what each file does.  

Here is what the awards listing looks like: 

 

 
* Award list for award ceremony 

OVERHDR 

* Change for number of overall male and female awards 

*            Number getting awards 

*              MALE/FEMALE 

*                     Gender 

*                       Age minimum 

*                         Age Maximum 

*                            Category 

*                                    Current record. (Can be omitted)   

* Macro no.  1 2      3 4 5  6       7 

@OVERALL.RSM 1 FEMALE F 1 99 OVERALL "Record              1:16:03 by 

Suzanne Gary in 1980" 

@OVERALL.RSM 1 MALE   M 1 99 OVERALL "Record              1:03:17 by Tom 

Carmon in 1981" 

 

* Change for number of overall masters male and female awards 

@OVERALL.RSM 1 FEMALE F 40 99 MASTERS 

@OVERALL.RSM 1 MALE   M 40 99 MASTERS 

* Age-groups 

AGERES.RSM 3 FEMALE F 40 49 "AGE GROUP" 

AGERES.RSM 3 MALE   M 40 49 "AGE GROUP" 

AGERES.RSM 2 FEMALE F 50 59 "AGE GROUP" 

AGERES.RSM 2 MALE   M 50 59 "AGE GROUP" 

AGERES.RSM 1 FEMALE F 60 99 "AGE GROUP" 

AGERES.RSM 1 MALE   M 60 99 "AGE GROUP" 

 

 

 

  Okay, first notice the comments or spacers behind the "*" for the listing file.  The first line will allow for the 

comment "Award list for award ceremony" to be shown on the bottom of the Listings Window to help the user 

understand what this file does.  Next, each section of the awards has a spacer and a comment of what each 

section does, thus the "* Overall awards" section does just that.  Now since we are doing composite awards, you 

need to come up with a header file that the Macro file calls and uses for each section change.  Thus the 

"Overhdr" file looks like: 
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Header 

 

.INCLUDE            RACENAME 

 

.ce ********** AWARDS LIST ************** 

 

.End of Header 

No Page Numbers 

No Column Headers 

Exclude             0 

.include            eventlst  

 

 

  This would produce the Racename at the top of the report and show that the first section to follow would be 

the "Awards List".  Just listing the file name, causes it to be used by the "@" macro file and start to create the 

awards list.  The next action from the macro, was to print out the "Overall" Male and Female finishers.  Thus, 

the macro called in the "@" macro file above: 

 
@OVERALL.RSM 1 FEMALE F 1 99 OVERALL "Record              1:16:03 by 

Suzanne Gary in 1980" 

@OVERALL.RSM 1 MALE   M 1 99 OVERALL "Record              1:03:17 by Tom 

Carmon in 1981" 

 

  This would call the RSM file called "@Overall.Rsm" and pass the parameters of %1 = "# awards/excludes", 

%2 = "title 1", %3 = “sex”, %4 =  “GE age”, %5 = “LE age”, %6 = “title 2”, %7 = “additional command”.   

Then, when you look at the "Overall.Rsm" file: 

 
* RunScore Macro for overall, masters, etc. 

no page numbers 

no column headers 

 

Header 

.ce ********** %2 %6 RESULTS *********** 

.End of Header 

.include            FIELDLST 

Field               AGE 

Field               CITY 

Field Length        15 

Field               STATE 

Field               CLUB 

records/page        %1 

.include            select.rsm 

.include            eventlst 

%7 

 

 

  You notice that %1 would become "1" for the number of awards and %2 and %6 would make the header now 

say "Female Overall Results", and the %7 would be used if you needed to pass note or command through the 

macro.  The “Select.rsm” makes all your selections to include the finishers you want to include or exclude in the 

awards and looks like: 
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* include file used for results and excludes. 

Select              SEX 

EQ                  %3 

and                  

select              age 

GE                  %4 

and 

select              age 

LE                  %5 

 

   You will notice that %3 allows you to select the sex value, GE age,  and LE age.  Once you repeat this for the 

second time with the Male data, the report would start to look like this: 

 
                         FORTIETH ANNUAL VERNON XX 

                        TWENTY KILOMETER ROAD RACE 

               USATF Certified.  Registration No. NY05034AM 

          Vernon, NY    06/19/2010  Weather: Cool, rainy, 58 deg 

  

                   ********** AWARDS LIST ************** 

 

               ********** FEMALE OVERALL RESULTS *********** 

    1 Adele Thompson       47 Afton           NY            1:14:44  

New record.  Old record 1:16:03 by Suzanne Gary in 1980 

                ********** MALE OVERALL RESULTS *********** 

    1 Ken Swift            53 Swift Town      KY Swift RR   1:03:44  

Record 1:03:17 by Tom Carmon in 1981 

               ********** FEMALE MASTERS RESULTS *********** 

    1 Anne Bender          63 Delaware        NJ            1:16:52  

                ********** MALE MASTERS RESULTS *********** 

    1 Steve Demo           54 Mount Morrow    NY            1:07:28  

                         FEMALE AGE GROUP  40 - 49 

    1    34 Patti Evans          42 Vernon             NY 1:24:33  

                          MALE AGE GROUP  40 - 49 

    1     5 Andrew Olson         40 Westtown           NY 1:08:21  

    2     8 John Smith           41 Carbondale         PA 1:10:35  

    3    45 Paul Winters         40 Mount Morrow       NY 1:39:47  

 

  Now, since most races do not let winners double dip on awards, you need to "Exclude" these people from 

further awards.  This is done with the "Exclude" command and the Macro file of "Exclude.rsm": 

  
* Exclude a specified number of runners 

No Page Numbers 

No Column Headers 

.include            select.rsm 

.include            eventlst 

Exclude             %1 

 

  Now, notice that from above, you select the same %1 in the “@Overall.rsm” file as the Overall awards, so you 

will Exclude the same number as you are giving awards to, thus here "1" and the same selection values that you 

used for the overall awards.  You now have removed the overall male and female from further awards 

consideration for this Macro Listing file.  You will now repeat this for the Masters, Grand Masters, or even 

walkers, just by changing the values called by “@Overall.rsm”. 
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  Once these overall winners are identified, we move to the Age Group winners.  This is done the same way as 

the Overall awards with coding in the “@Awards.lst” that calls for a number of awards for each sex and age 

group.  Thus, the Age Group listing looks like this: 

 
* Age-groups 

AGERES.RSM 3 FEMALE F 40 49 "AGE GROUP" 

AGERES.RSM 3 MALE   M 40 49 "AGE GROUP" 

AGERES.RSM 2 FEMALE F 50 59 "AGE GROUP" 

AGERES.RSM 2 MALE   M 50 59 "AGE GROUP" 

AGERES.RSM 1 FEMALE F 60 99 "AGE GROUP" 

AGERES.RSM 1 MALE   M 60 99 "AGE GROUP" 

 

The above macro calls the RSM file for age groups, "Ageres.rsm": 

 
No Page Numbers 

No Column Headers 

conditional ff      5 

Header 

.ce %2 %6  %4 - %5 

.end of header 

Overall Place 

.include            select.rsm 

Records/Page        %1 

* Following is for Record command if present 

%7 

.include            fieldlst 

Field               AGE 

Field               CITY 

Field               STATE 

.include            EVENTLST 

 

  You notice that %1 would become "3" for the number of age group awards, %2 would add “Male or Female” 

in the header , the %6 would Place “Age Group” in the header. 

  When you include “Select.rsm”, it makes all your selections to include the finishers you want to include or 

exclude in the awards. 

 
* include file used for results and excludes. 

Select              SEX 

EQ                  %3 

and                  

select              age 

GE                  %4 

and 

select              age 

LE                  %5 

 

  You notice that the values from “@Awards.lst” continue filling in “Select.rsm” to fill %3  with “M or F” for 

the sex value, %4 fills with the lower age of the award, and %5 fills with the upper age for the award. 
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Advanced RunScore 
 

  Now that you have gained a basic understanding of RunScore, you can continue to use RunScore and learn 

more and better ways to use the program.  As you become more familiar and confident with RunScore, you can 

start looking at the races in the “Advanced Sample Races” folder.  These race samples will let you do more 

complex races and provide you with more capabilities than the basic “Sample Race” files will allow you to do.   

You will find yourself being able to score complex races and understand how they are done in the Advanced 

Samples.   

 

  You will find a large amount of listing files in each of those races to do all the functions that the other Race 

Scoring programs out there do for you.  But, unlike the other programs, you can make the changes that you need 

on the fly and not have to wait for them to send you new files.  With RunScore, you can make changes to your 

results at any time and score your race, even with major changes on race day. 

 

  Remember to “Practice, Practice, Practice……” to be ready for any situation that comes up on your race.  

Don’t go into a race cold, make sure that you are ready for the race and understand what your hardware and 

software will do for you. 

 
 


